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采用流体体积法研究多相流

13. A3 Multiphase flow using VOF

Focus: in this example, first the background of

multiphase flow is introduced, and then Volume of

Fluid method is discussed in detail.
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 Problem description：The computational domain

is a 2D channel. Air with velocity of 5 m/s flows into

the channel from the left inlet; and water with

velocity of u=0.1m/s enters the channel from a micro-

pore at the bottom.

13. A3 Numerical simulation of multiphase flow using 

volume of fraction(VOF) method

Fig.1 Computational domain and geometry sizes (μm)
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 Find: water dynamic behavior, pressure drop, and

saturation in the channel;

The boundary conditions are as follows:

Fluid flow

Air inlet Velocity inlet

Water inlet Velocity inlet

Outlet Outflow

Bottom Wall, 140o

Up Wall, 60o
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1. Background of Multiphase flow

6/76

Multiphase fluid flows are widely encountered in natural,

scientific and engineering systems

Same component （单组分多相流) 

Multiple components （多组分多相流）

Liquid water and water vapor system

H2O

Liquid water and air system, H2O, N2, O2…
Crown

A phase refers to gas, liquid or solid state of matter. A multiphase

flow is the flow of a mixture of phases, such as gas (bubbles) in a

liquid, or liquid (droplets) in a gas, and so on.
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2. Fundamental definitions

Surface tension: refers to the tensile force exists at the

phase interface separating two fluids, due to a mutual

attraction between molecules near the interface

unit: N/m   Typical value: water-air: 0.0725 N/m
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Water striders stay on top of water

（水面上的水黾） Lotus effect (荷叶效应）
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θ>90 θ=90 θ<90

Contact angle
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measurement of the surface wettability. The angle of

the triple-phase line. Hydrophilic surface (亲水) with

angle less than 90, liquid tends to spread. Hydrophobic

surface (疏水) with angle higher than 90, liquid tends

to form droplet. Neutral surface with angle as 90.
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p1
p2

Capillary pressure

𝑃c = 𝑃1 − 𝑃2 =
𝜎cos𝜃

𝑟
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pressure difference across a phase interface, related to 

the surface tension force 

Because of the capillary

pressure, a liquid can flow

in narrow spaces without

the assistance of, or even in

opposition to, external

forces like gravity.
mercury
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2. Different methods for multiphase flow

Volume of Fluid (VOF) 流体体积法

Macroscopic

Level Set (LS) 水平集法

Phase-field 相场方法

Front tracking  前沿跟踪方法

Mesoscopic

Lattice  Boltzmann Method, Smooth Particle Hydrodynamics

（格子Boltzmann 方法， 光滑粒子方法）

Microscopic

Molecular dynamics （分子动力学）

VOSET

by NHT group
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3. Volume of Fluid (VOF)

Proposed by Hirt and Nichols in 1981.

In fact, VOF is one of the most popular methods for multiphase

flow. It has been successfully adopted for a wide range of

problems, and is till being improved and enhanced.
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Volume of fraction（体积分数): the basic variable in VOF

The volume fraction of each fluid in a computational cell

cell

m
m

V
C

V
 1mC 

For two-phase flow: primary phase(主相) and secondary 

phase (次相)。

1 1C  The cell is filled with the primary phase

1 0C  The cell is free of primary phase

( , )1 0 1C  The cell is partially filled with primary phase
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Schematic of 2D two-phase flow system

1 1C  The cell is filled with the primary phase

1 0C  The cell is free of primary phase

( , )1 0 1C  The cell is partially filled with primary phase

primary phase

secondary phase
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Governing equation of C

1. The change of C is due to the flow in/out of the

corresponding phase into a cell.

2. C is evolved according to local velocity obtained from

solving the N-S equations.

0m
m

C
C

t


  


u

Unsteady term Convection term

The two phases are not soluble (互溶）, so there is no

diffusion term. When there is chemical reaction or

phase change, source term is not zero.

Convection-diffusion type equation
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The governing equations for multiphase phase flow

using VOF
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
F

CSF model

Surface tension force

u from NS equation

Two-way coupled with each other.
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Continuum surface force (CSF) model

CSF transfer the surface tension force to volumetric force

 Smooth C

 VOF in fact is a sharp-interface

model.

 The thickness of the interface is

zero.

 C is sharply changed from 1 to 0

across the interface.

The form of volumetric force is required in NS equation. 

However, surface tension force is a kind of surface force, 

rather than volumetric force.
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The purpose of smoothing C is to make C changes

gradually from 1 to 0.

C Water

Gas

C=1

C=0.75

C=0.5

C=0.25

C=0

In microscopic, however, the interface is not sharp, it

has a finite thickness, for example, of a few nanometers.

Therefore, transition from phase 1 to phase 2 is smooth.
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, , , ,

,

( , )i j m n i j m n

m n

C C K   r r

The following function is adopted to smooth C


Control the thickness of the interface! 3∆

i , j

m,n

, ,i j m nr r

Distance between two points (i,j) and (m,n)

K Smooth integration kernel

Smoothed one
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l

l

1
( )
| |

C
k

r C


  



interface mean curvature

Smoothed C, namely      , is adopted to calculate forceC

C n

pressure in the transition region is

g g( )x x g xP P k C C P kC     

g( ) ( ( ))x x gP P k C C

k C





    

 

F ~

Suppose local k is constant.

l
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k
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0m
m

C
C

t


  


u

( ) 0m
m

C
C

t


 


u

Conservation form

1. This is a convection-diffusion equation without diffusion term,

and can be solved using schemes (such as QUICK) introduced in

NHT.

How to solve the VOF equation?

However, because C is not a continuous function. Such method

may result in false diffusion, leading to gradually increasing

thickness of the interface.
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2. Reconstruction method

Step 1. Interface reconstruction

For a value of C in a computational cell, the pattern of interface

should be determined first.

For example, for C=0.5, the interface may be as follows.

Then which one is the right interface?

1

2

3 4 5

…
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There are totally 16 kinds of interface pattern,

depending on local C and normal direction (nx, ny)

1. nx>0, ny>0

2. nx>0, ny<0

3. nx<0, ny<0

4. nx<0, ny>0

rotate

translation

mirroring
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Normal direction of the interface

Interface normal direction

Volume of fraction
Interface is reconstructed!

For example, for C=0.5, nx=0, ny=1

1

2

3 4 5

…

/
/
/
/


24/76

Normal direction of the interface

Interface normal direction

Volume of fraction
Interface is reconstructed!

…

~ ~ ~ ~ ~ ~

~ ~ ~ ~ ~ ~

For example, for C=0.5, nx= , ny=/1 2

1

2

3 4 5

/1 2
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By the reconstruction scheme, the phase interface is

determined in each computational cell.

Piecewise linear interface calculation (PLIC)

The smooth interface is approximately described by a 

set of lines.

D.L. Youngs, Time-dependent 

multi-material flow with large 

fluid distortion, Numerical 

methods for Fluid Dynamics, 1982, 

24(2), 273-285
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Step 2. Interface advection in a given velocity field

Based on the reconstructed phase interface, calculate

the variation of C according to local velocity filed, and

then update the C for next time step.

Taking 1D interface as example.

i-1 i i+1

Ci-1=1 Ci+1=0Ci

∆x

Ci∆x u
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i-1 i i+1

Ci∆x

The volume that flows from i-1 to i is

-1/2 -1/2i iF u t 

-1/2iu

The volume that flows from i to i+1 is

1/2

1/2

1/2 1/2

0 (1 )

(1 ) (1 )

i i

i

i i i i

u t C x
F

u t C x u t C x





 

   
 

       

∆x

1/2iu 

(1 )iC x 

Total volume is
1/2 1/2( ) /t t t

i i i iC C F F x

    
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1/2 1/2( ) /t t t

i i i iC C F F x

    

CFL condition

/u t x 
Because C should be smaller than 1, thus

also should be smaller than 1. This is the CFL

condition.

/u t x 

Therefore, during the numerical simulation, the time

step should be sufficiently low that the CFL condition

is satisfied, or the Courant number <1.

Courant number 
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The governing equations for multiphase phase flow

using VOF

( )
( ) 0

t





 


u

T( )
( ) [ ( )]p

t


  


       



u
uu u u g F

l l g gC C    l l g gC C   

0m
m

C
C

t


  


u

l

l g

2
( )

C
k




 





F

CSF model

Two-way coupled with each other.
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2.1 Launch ANSYS Fluent

 Choose 2-Dimension

 Choose Display Options

 Choose Double Precision

 Choose Serial Processing

2  Process of simulation
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2.2 Read the mesh

File → Read→Mesh
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General→Mesh→Check

2.3 Check the mesh
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 Choose Specify Scaling Factor

 Write 0.000001 in the Scaling Factor box to convert

the unite from m to μm.

2.4 Scale the domain size

General→Mesh→Scale
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2.5 Choose the solver

 Choose Transient

The dynamic behaviors of

water is to be studied.

General→Solver

 Select Gravity

 Write -9.8 in the

Gravitational

Acceleration box

of Y.

Density-based method cannot be used for VOF.

/
/
/
/


35/76

2.6 Choose the models

Solution Setup→Models

 Choose Volume of Fluid as Multiphase Model

 Coupled Level set +VOF?
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Coupled Level Set +VOF

LS function is smooth and

continuous, accurate!

Advantages

LS is not good.

VOF is discontinues across the

interface, not accurate

VOF is good.

Combining the advantages of LS and VOF

Spatial gradient (interface curvature and surface tension 

force)

Mass conservation

√

√
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2.6 Choose the models

Large body forces (for example,

gravity or surface tension forces)

are included.

Implicit body force is adopted to

improves solution convergence by

accounting for the partial

equilibrium of the pressure

gradient and surface tension

forces.

Body force formulation
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Forces in  Momentum equation

T l

l g

( )
( ) [ ( )] 2

( )

C
p k

t
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 
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 

u
uu u u g

Inertial force

Pressure

Viscous force 

gravity Surface 

tension 

force

Multiphase flow is controlled by a set of forces. 

Body force

* Here surface tension force is converted to body force using CSF.
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2.7 Define the materials

Solution Setup→ Materials→Create/Edit Material

 Create water-liquid

1. Click Fluent Database

2. Choose water-liquid

3. Click Copy
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2.8 Define the phases

Solution Setup→ Phases

 Choose air as Primary Phase

 Choose water-liquid as Secondary Phase



Primary phase is usually set as the one dominated in the 

computational domain.
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2.8 Define the phases

1. Click Interaction

2. Click Surface Tension

3. Select Surface Tension 

Force Modeling

4. Choose Continuum 

Surface Force and Wall 

Adhesion.

5. Choose constant and 

write 0.0725.

Define surface tension force
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2.9 Define cell zone conditions

Solution Setup→ Cell Zone Condition →Operating Conditions 

 In Fluent, operating 

pressure is the same 

as reference pressure. 

Operating pressure

 Input location and 

value of operating 

pressure.
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2.9 Define cell zone conditions

Solution Setup→ Cell Zone Condition →Operating Conditions 

Specified operating density

Set the operating density to be the 

density of the lightest phase.

Here input the density of the air.
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2.10 Define the boundary conditions

Solution Setup→ Boundary Condition

 For the left inlet, pure air 

flows into the domain.

 Velocity inlet is adopted 

for the mixture.

 Volume fraction of each 

phase should be given.

/
/
/
/


45/35

2.10 Define the boundary conditions

For the top and bottom surface, Define contact angle

 Choose wall as Type 

 Input value of the contact 

angle 140o

 The angle is measured by 

water here.
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2.10 Define the boundary conditions

For the water inlet, define velocity inlet condition;

define the volume fraction of water as 1.
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2.11 Choose the solution methods

Solution → Solution Methods 

 Choose PISO (Scheme)

 Choose Green-Gauss 

Cell Based (Gradient)

 Choose Body Force 

Weighted (Pressure)

 Choose Second Order 

Upwind (Momentum)

 Choose Geo-Reconstruct 

(Volume Fraction)
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The Pressure-Implicit with Splitting of Operators (PISO) 

The PISO also belongs to the family of SIMPLE.

There are one time of prediction step (预估） and correction 

step (校正） in SIMPLEC. 

Prediction step: determine u* and v* based on u0 and v0

Correction step: solve pressure correction, obtain u and v that 

satisfying the Mass Conservation Equation.

In PISO, two times of correction steps are conducted, thus 

improving the convergence.

PISO is  recommended for transient problem.
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2.11 Choose the solution methods

Solution → Solution Methods 

 Choose PISO (Scheme)

 Choose Green-Gauss 

Node Based (Gradient)

 Choose Body Force 

Weighted (Pressure)

 Choose Second Order 

Upwind (Momentum)

 Choose Geo-Reconstruct 

(Volume Fraction)

/
/
/
/


50/76

Gradient calculation

The former two are based on Green-Gauss Theory

1. Green-Gauss Cell-Based (格林-高斯基于单元法）

2. Green-Gauss Node-Based (格林-高斯基于节点法)

3. Least-Squares Cell Based基于单元体的最小二乘法

It is the default scheme for gradient calculation.

1 1

C

f

C CV

dV dS S
V V

             n n

The least-square cell based is based on 

2

0

1

N

i Ci C i i i
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w x y z
x y z
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      
          

      


  
 
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2.11 Choose the solution methods

Solution → Solution Methods 

 Choose PISO (Scheme)

 Choose Green-Gauss 

Node Based (Gradient)

 Choose Body Force 

Weighted (Pressure)

 Choose Second Order 

Upwind (Momentum)

 Choose Geo-Reconstruct 

(Volume Fraction)
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4. Body Force Weighted scheme

Calculate the pressure according to the body force.

 Multiphase flow such as VOF (Volume of Fluid，体

积函数法) or LS (Level Set, 水平集): recommended.

 For porous media: not recommended!

5. PRESTO! (Pressure Staggering Option) scheme

For problem with high pressure gradient.

1. Linear scheme

2. Standard scheme

3. Second Order

Pressure calculation
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2.11 Choose the solution methods

Solution → Solution Methods 

 Choose PISO (Scheme)

 Choose Green-Gauss 

Node Based (Gradient)

 Choose Body Force 

Weighted (Pressure)

 Choose Second Order 

Upwind (Momentum)

 Choose Geo-Reconstruct 

(Volume Fraction)
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The geometric reconstruction interpolation scheme is

recommended when time-accurate transient behaviors

of the multiphase are required. In other words, it can

accurately predict the sharp interface.

This scheme is the most accurate and is applicable for

general unstructured meshes.

Solving methods for VOF equation

Modified HRIC, Compressive, and CICSAM schemes

are less computationally expensive than the Geo-

Reconstruct scheme, the interface between phases will

not be as sharp as the geometric reconstruction

interpolation scheme.
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2.12 Define the monitors

Solution → Monitors

 Define the Residuals Monitor and write 0.0001 in 

the Absolute Criteria box
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2.12 Define the monitors

 Create the Surface Monitor 

1. Change the Name

2. Choose the Report Type and Surface
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2.13 Initialize

Solution → Solution Initialization

 Choose Standard 

Initialization

 Choose air-in

 Click Initialize
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2.14 Run  calculation

Solution → Run  Calculation

 Write Number in Time 

Step Size box

 Write Number in Number 

of Time Step box 

according to situations 

 Write Number in Max 

Iterations according to 

situations 
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2.14 Run  calculation

 Time Step Size(s) sets the magnitude of the (physical) 

time step  . Courant number < 1 should be satisfied.

 Number of Time Steps sets the number of time steps 

to be performed.

 Max Iterations/Time Step sets the maximum number 

of iterations to be performed per time step. If the 

convergence criteria are met before this number of 

iterations is performed, the solution will advance to 

the next time step.

t
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Summary

1.Read mesh                                 

2.Check mesh

3.Scale domain 

4.Choose solver (transient, gravity)

5.Choose model (VOF, explicit, courant number, implicit 

body force)                      

6.Define material (water-liquid)

7.Define phase (primary phase, secondary phase,       

interaction, surface tension, wall adhesion)
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8.Denfine operating condition (reference pressure location,

specified operating density)

9.Define boundary condition (volume fraction, contact 

angle)

10.Choose solution method (PISO, Green-Gauss cell based,

Body force weighted )

11.Define monitor (residuals monitor, surface monitor)                   

12.Initailize (standard initialization)

13.Run the simulation (time step size)          

14.Post-process
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Fig.2 water behavior

3 Results
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T=8.868e-4 T=5.7064e-3

T=8.5285e-3 T=9.9285e-3

/
/
/
/


Fig.2 water behavior

3 Results
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T=1.1028e-2 T=1.0328e-2

T=1.0529e-2 T=1.0729e-2
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Homework

Known：Porous medium is partially inserted into an 2D

channel to enhance the heat transfer. The fluid is

water and the porous region is aluminum metal foam.

The porous region is attached to the outer wall of the

channel.

Computational domain

Porous region

Water flow

qconstant

L

H1

H

qconstant
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Parameter H L

Value

(Unit)

0.06

(m)

3

(m)

998.2

(kgm-3)

99810-6

(kgm-1s-1)

4182

(Jkg-1K-1)

0.597

(Wm-1K-1)
0.9

water
p water

c
water


water



Boundary Condition

x=0 vx=Uin , T=300 K

x=L p=0 Pa , Tbackflow=300 K

y=0 symmetry

y=H vx=vy=0

Porous region Thermal-

equilibrium model

-2
500Wmq 

Boundary 

conditions 

Assumptions: 

constant physical properties, steady, laminar flow 


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Solve: base case

base case

/

/

Nu Nu
PN

p p

 

Simulate the heat transfer and laminar flow based on above

conditions. Analyze the Nu, pressure drop (∆P) and PN at

different Re and permeabilities (every one in the same group

will run totally 16 cases). Thermal-equilibrium model is

adopted for porous medium region. KC equation is adopted to

calculate the permeability.

inlet
Hu

Re





2 3

2150 1

p

( )

D
k







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Traffic control in Xi’an

Haze
In each working day, cars

with two values of tail

number are not allowed on

road.

Monday: 1, 6

Tuesday: 2,7

Wednesday: 3,8

Thursday: 4,9

Friday: 5,0
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Homework

The homework is divided into 5 groups based on

different tail numbers of student ID.

123456578
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Group 1 Thickness of porous region H1

0.02 (m)

Re=100 Re=200 Re=300 Re=400

0.0025 0.0025 0.0025 0.0025 0.0025

0.00079 0.00079 0.00079 0.00079 0.00079

0.00025 0.00025 0.00025 0.00025 0.00025

0.000079 0.000079 0.000079 0.000079 0.000079

Base case

Tail numbers of student ID: 1, 6

Re
Dp

Dp is the diameter of particles
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Group 2 Thickness of porous region H1

0.03 (m)

Re=100 Re=200 Re=300 Re=400

0.0025 0.0025 0.0025 0.0025 0.0025

0.00079 0.00079 0.00079 0.00079 0.00079

0.00025 0.00025 0.00025 0.00025 0.00025

0.000079 0.000079 0.000079 0.000079 0.000079

Base case

Tail numbers of student ID: 2, 7

Re
Dp

Dp is the diameter of particles
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Group 3 Thickness of porous region H1

0.04 (m)

Tail numbers of student ID: 3, 8

Re=100 Re=200 Re=300 Re=400

0.0025 0.0025 0.0025 0.0025 0.0025

0.00079 0.00079 0.00079 0.00079 0.00079

0.00025 0.00025 0.00025 0.00025 0.00025

0.000079 0.000079 0.000079 0.000079 0.000079

Base case

Re
Dp

Dp is the diameter of particles
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Group 4 Thickness of porous region H1

0.05 (m)

Tail numbers of student ID: 4, 9

Re=100 Re=200 Re=300 Re=400

0.0025 0.0025 0.0025 0.0025 0.0025

0.00079 0.00079 0.00079 0.00079 0.00079

0.00025 0.00025 0.00025 0.00025 0.00025

0.000079 0.000079 0.000079 0.000079 0.000079

Base case

Re
Dp

Dp is the diameter of particles
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Group 1 Thickness of porous region H1

0.055 (m)

Tail numbers of student ID: 5, 0

Re=100 Re=200 Re=300 Re=400

0.0025 0.0025 0.0025 0.0025 0.0025

0.00079 0.00079 0.00079 0.00079 0.00079

0.00025 0.00025 0.00025 0.00025 0.00025

0.000079 0.000079 0.000079 0.000079 0.000079

Base case

Re
Dp

Dp is the diameter of particles
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同舟共济渡彼岸!

People in the same boat 
help each other to cross 
to the other bank, 
where….

Happy New Year

感谢各位同学

感谢陶老师！
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同舟共济
渡彼岸!

People in the same 
boat help each 
other to cross to the 
other bank, where….
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